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This is an intro paragraph. Erum etur, ut ea net utem evendi doluptas nisquiatur samus dolorerio. Ni vel excest, vendias explitemque volenet es accae corumquiatem eum laut estet andae nima eosandit lam voluptusaped etum ni consequia quasper epelibe aquatetur, qui ipitaqu issitaquae non cum samenditis eat.


THIS IS A SECTION HEADING
Ullabo. Nem que quodipsam, con paris mi, tem quodignihil id maiore, qui nullit mo te nostis ex erehenis estis et et eum alique lanis rectisci ut que ipid eictur alignis sim rerum quiatum acea in ped quae maximinus.

Primary Bullet Style. Perio con es rem nullati cores et mo idit omnis volesti quae exceatioris unt as rente quis re re cor apitas dempos repro dolorum est et laut ommodit asperrum eum.
Nonsequis arum eatempo reperit, qui te sit, officillab in pa dolupta sequam aut volenissim ut fugitae des estion porest, soluptiorio volorisque qui demporem qui quam conetur.
Secondary Bullet Style. Ma quis magnatem eos de vernatiusam ut a cone comnitaspe consequatur, volorecus, et lacepero tem laboreiciis eatum at re peror archit audantia diti cum utempel lessitas dolende dolorrovit aliquam comnima cum nam doluptatur sinis am fugiatq uistem. 
Ga. Omniet as ipicidel miliquae volor simus es magnatem dolupta mendaepuda dolupta ssequatet mint dolorem verae nos cum quiae pera sit omnis eati quam es velitatur alitati doluptibus.
Luptas aut officidel incias ra eos plibus esero odit aut et laborunt, aut la volest, occusam enditius modis accatib uscimin rerunda quis est lat ullatius aut voluptatem quas doluptassi bea quuntias es ellum volecum idebitatia quid quia si abo. 
Facimentiis que sunto is magnimu sandae nis intem volest harchil licaepe rsperesequam autatur molupta is et ipid molor seque praectatur secesti tem voles quatiun tiatio dis minitam, simint late proribus et omnim consequi ditibus rest veriatu ritias dis cum qui omnihit aut qui consedi tatium, eat.

THIS IS A SECTION HEADING
Numbered Bullet Style. Xerrorepre, ut undicia veris ressendi consequis accuptatius etur rende veliquodita nobis sandeli quidem quia vel mo eat qui ut ventio. 
Sequae poremoditam dolut et ad modi vent quas veligenis eatur? Tur, commolendes dolupta is et ex etur re seque core si occum voluptat volut officiu ntionsequi occatur? 
Ent eario. Itatatus es ea di ommoloribus, aborerisqui.




This is a Table Style
TABLE HEADING
TABLE HEADING
TABLE HEADING
Content
Content
Content
Content
Content
Content
Content
Content
Content
Content
Content
Content
Content
Content
Content
Content
Content
Content





This is a Callout Layout
This is a callout box. Minis rem inctet fugit ea antis earum fugiae pla inullor rest ipit et estor siti bersperi omnis volorib eatiur solorupta que sequo que voluptas eostibus ea doloribus ut ipitatium nis rerisqui id expere vel is ea doluptibus asperatius as ea atectio tent aut omnihic iendit iunt quat.
This is a callout box. Minis rem inctet fugit ea antis earum fugiae pla inullor rest ipit et estor siti bersperi omnis volorib eatiur solorupta que sequo que voluptas eostibus ea doloribus ut ipitatium nis rerisqui id expere vel is ea doluptibus asperatius as ea atectio tent aut omnihic iendit iunt quat.
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	Porporep eribusdaest excessequi cus.Hicab ipsuntion es etumque nia consequodi blam con nihit fuga. Porererum assit ex endione nobis ipid most ut ut et plabore mporia volorepta nistium volo to volupta sitatia sitibus quassunt 
et rest del inv.

Eritis nobis esequae re vel magni dolecus voluptis preriti oreicilla vene aut doloris sitiste nemolo mincienist laborero bero blate eum doluptatus sa voluptatem fugitiae. Ro bearum ratur, culparum quis et omnis est explia volorectoria et poriass undant as mod estinci psapiet es sequis et quae volorer ferio. Tusaniet laborup tas doluption nimi, quid quaectasi ressi optur modiciis pre volorepuda del iment estiur? Dus aut ant.
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This is a Flow Chart Style
Employee
Inputs bi-weekly timesheets
Completes and submits timesheets by end of Friday before payroll processing 
week
Paycheck/Direct Deposit received on the following Friday
SUPERVISOR/CHIEF
Reviews and edits employee timesheets
Approves timesheets by 
12pm on Monday of payroll processing week
Paycheck/Direct Deposit received on Friday






















This is a Timeline Style


Q1 2022
Idic tempedita quo dolorehendus mosa 
Tem sequis et
Q3 2022
Idic tempedita quo dolorehendus mosa Tem sequis et
Q1 2023
Idic tempedita quo dolorehendus mosa Tem sequis et
Q4 2022
Idic tempedita quo dolorehendus mosa Tem sequis et
Q2 2022
Idic tempedita quo dolorehendus mosa Tem sequis et
Q2 2023
Idic tempedita quo dolorehendus mosa 
Tem sequis et
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January 2022
Idic tempedita quo dolorehendus mosa Tem sequis et
March 2022
Idic tempedita quo dolorehendus mosa Tem sequis et
April 2022
Idic tempedita quo dolorehendus mosa Tem sequis et
July 2022
Idic tempedita quo dolorehendus mosa Tem sequis et
August 2022
Idic tempedita quo dolorehendus mosa Tem sequis et
Decemer 2022
Idic tempedita quo dolorehendus mosa Tem sequis et
















Template Guidelines

The PAGNY Template 
Use this pre-formatted document as a template to create single and multiple page documents. 
Additional files are not needed to use this template. 
If desired, save this file as a “.dotx” template file. 
This template requires the following fonts which are installed with all versions of MS Word: 
Franklin Gothic Book 
Franklin Gothic Demi

Word settings
Work in Word’s “Print Layout” View. Select “Print Layout” from the View Menu 
Work with the Formatting Marks Visible to see necessary formatting symbols such as Hard/Soft Returns, Page Breaks, Table Selection Icons and Object Anchors: 
Select “Options” from the File Menu. 
Select “Display” and then “Show All Formatting Marks”. Select “OK”.

To Create a New Document
Open and resave this file with your own filename by selecting “Save As” from the File menu.
Save an unedited copy of this Template for reference in case you ever need to retrieve the original document formatting, layouts, and styles.

To Edit the Footer
1. Double-click inside of the Footer area on any page to open it. 
Highlight the existing Footer text and type new text to revise it. The changes made to the Footer will be applied to all pages in the document. 
To close the Footer, press Escape, or double-click on an area of the page outside of the Footer. 
Note: The Cover (Title) Layouts do not display the Footer by design. 

[bookmark: _Hlk125629588]To create and remove pages 
Duplicate and revise pre-formatted pages as needed. Highlight all of the page contents to select it, including the Page Break at the bottom of the page, if one exists. Then “Copy” and “Paste” the contents onto a new, blank page. 
[bookmark: _Hlk125556157]To remove a page, highlight all the page contents to select it, including the Page Break if one exists, then “Cut” or press the Backspace key.
To create a new, blank page in the middle of a document:
1. Navigate to the page that will appear before the new page. If it already has a Page Break at the bottom of the page, place the cursor after the Page Break Marker and press ENTER which will position the cursor on the next page. If it does not already have a Page Break, create one by placing the cursor below all page content and pressing CTRL-ENTER. This will also position the cursor on the next page. 
1. Press ENTER again (on that next page) and create another Page Break (CTRL-ENTER). There will now be a blank page with two Paragraph Return Markers: one empty, and one containing a Page Break. 
1. Creating a Page Break will place a Paragraph Return on the following page, which is not always needed. Go to the page after the new, blank page that was just created and remove the extra Paragraph Return at the top of that page. 
To create page content
Duplicate and revise pre-formatted page contents as needed. Highlight the contents to select it, then “Copy” and “Paste” in a new location. 
Highlight and type over existing text to revise it.
When pasting text from a different source, use "Paste Special / Unformatted Text" or “Keep Text Only” to prevent pasting unwanted source formatting along with the text.

To Apply text Styles
From the “Home” tab, open the Styles task pane by clicking the bottom right corner Expansion Arrow in the “Styles” section. Select “Show Preview” at the bottom of the Styles task pane. 
Apply a text Style by highlighting an entire line or block of text (including the Paragraph Return marker) and selecting a PAGNY Style from the Styles task pane. 
Use only the PAGNY Styles beginning with the “_PAG” prefix.

To Change the Cover (title Page) Layout
1. [image: ]Navigate to the first page of the document. Remove the existing Cover layout by clicking on the Table Selector Icon. This will highlight and select the entire contents of the Cover. Then press the Backspace key (not the Delete key) or “Cut” to remove both the table and its contents. 
1. Two Paragraph Return markers will remain at the top of the page: one empty, and one containing a Page Break. Leave them there.
1. Navigate to the desired Cover layout in the template and click on the Table Selector Icon. The contents will be highlighted to show that it is selected. Then “Copy” or “Cut”. 
1. Return to the first page and place the cursor before the first Paragraph Return marker at the top of the page. Then “Paste”. The Cover layout will now be positioned on the first page. 
1. To remove extra Cover pages, click on the Cover layout’s Table Selector Icon and press the Backspace key (not Delete) or “Cut”. Then select the remaining Paragraph Return markers and Page Brake and press Delete, Backspace or “Cut” to remove them. 

To position A Divider page
1. Begin by creating a blank page for the Divider. See “TO CREATE AND REMOVE PAGES”.
Navigate to the desired Divider layout in the template and click on the Table Selector Icon. The contents will be highlighted to show that it is selected. Then “Copy” or “Cut”. 
Return to the blank page and place the cursor before the first Paragraph Return marker at the top of the page. Then “Paste”. The Divider layout will now be positioned on the page. 
To remove extra, unneeded Divider pages, click on the Divider layout’s Table Selector Icon and press the Backspace key (not Delete) or “Cut”. Then select the remaining Paragraph Return markers and Page Brake and press Delete, Backspace or “Cut” to remove them. 


Team page layouts
As with the Cover and Divider layouts, the three Team page layouts are formatted using tables. 
To add or remove rows or columns, see “WORKING WITH TABLES”. 
To move a Team layout to a different location, select the table by clicking on the Table Selector Icon. Then “Cut” or “Copy” and “Paste” it to a new page or location.
To remove a Team page layout entirely, select the table and “Cut” or press the Backspace key. Then select all remaining text and “Cut” or press the Delete or Backspace key. 

To Replace A “Team” Photo 
1. Use Photoshop or other software to adjust a picture’s size and cropping, before placing it into a document. 
1. To replace an existing image, right-click on it and select “Change Picture”. Navigate to the new picture, select it, and select “Insert”.

[bookmark: _Hlk125632299]Working with Tables
To select an entire Table:
Click on the Table selection icon. Click within the Table and hover over the upper left area of the Table to locate it. The Table contents will be highlighted when it is selected. 
When the table is selected it can be removed or Copied and Pasted to a new location. 
To Add or Remove a Table Row or Column:
Place your cursor within the text of the table, right-click and select either “Insert Row Above” (or “Below”), or “Insert Column to the Left” (or “to the Right”). 
Make additional selections from the Table “Layout” menu that appears when the cursor is placed within a table or parts of it are selected. 

Callout, Flow Chart and Timeline layouts
The Callout, Flowchart and Timeline layouts are created with Word Shapes and objects which are Grouped and “Anchored” to a Paragraph Return. 
Click on any object to locate the object’s “Anchor” symbol. Moving or removing the Paragraph Return that an object is anchored to, will also move/remove the object. 
To select an object or group of objects, either click on it or the paragraph return it is anchored to. To select an individual object, it may be necessary to ungroup the objects first. 
Move objects by either dragging them with the mouse or by using the arrow keys.
Select and type over existing text to revise it.
Reformat objects using the Shape Format menu that appears when you select a Shape.
Duplicate objects using “Copy” and “Paste”. Remove objects using “Cut” or the Delete or Backspace key.
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